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Introduction To Enhanced Eureka

This section of the Eureka training and reference manual describes some of those functions which in 
most cases are not “routine” to the every day user.  Among the topics covered are inserting charts 
and crosstabs into your reports and queries.  You will also learn how to generate labels with informa-
tion drawn from your DPAS data.  Finally, you will learn how to create and use a Personal Data Mart.

OBJECTIVES

You will gain a familiarity with the advanced functions found in this chapter, so that you can use them 
when the occasion arises.

APPLICATION

A chart may be an excellent way to represent items on your Property Book, for example, number of 
items entered into the property book per month, in order to show trends in how work is distributed.  
A Personal Data Mart can be a tool used to facilitate your work in developing reports remotely from 
your on-line database, or to limit the amount of data which your report will look at. 

PREREQUISITES

A fundamental understanding of FreeForm documents.

ACTIVITY

Student Hands-On with Instructor direction



Charts
Charts

Unit of Study:  Chart objects generate their own query that is completely separate from the initial 
main document query.  A chart object is used to illustrate graphically your report output.

Eureka allows you to include eight different types of charts in your document:

Three-dimensional area charts
Two-dimensional and three-dimensional bar charts
Two-dimensional and three-dimensional line charts
Two-dimensional and three-dimensional pie charts
Scatter chart

Experiment with different chart types for displaying your data. As a general rule, the more complex your 
data, the simpler a chart type you should start with.

Application:  Property listing with output to include a chart object to illustrate graphically your data 
results.

Report Type:  Asset listing by HRH Nbr Mjr, HRH Name with Bar Cd and Acq Cost.

Activity:  Student Hands-On with Instructor direction

Instructions:

1. Create a new FreeForm report.
2. Select the following fields for your FreeForm report:

BUSINESS VIEW:  END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)

Hand_Receipt_Holder HRH Nbr Mjr
HRH Name

Serial_Hand_Receipt Bar Cd
Acq Cost
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Charts
3. Save your report as CHART.
4. Process your query.

5. Close the report viewer.

6. Select the chart icon  from the tool bar.
7. Place the chart object into the Page Footer area of your document.
8. Click on the chart object and drag out to enlarge the icon to about half a page.

9. Double-click on the chart icon.

NOTE:
A chart is only as big as the chart object that is placed on your report.  You will need to resize 
the object by grabbing the handles (click on the object once to get the handles) and drag the 
object to the desired size.
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Charts
10. Select the Chart Types button.
11. Select 3D Pie.

12. Title:  Enter $ By HRH Nbr Mjr.
13. Click on the Objects button.
14. Double-click on the Detail folder.
15. Click, drag and drop the Acq Cost field to the Pie Slice Values.  This field is grayed out, but you will 

still be allowed to drag the object into the field.
16. Click, drag and drop the HRH Nbr Mjr to Pie Slice Labels.  This field is grayed out, but you will still 

be allowed to drag the object into the field.
17. In the Chart Attributes group, check Display Legend.
18. In the Gradient group, accept the default of None.

Gradient

Top Down White at the top blending to black at the bottom.

Center Out White in the center blending to black at the outside.

Bottom Up White at the bottom blending to black at the top.

NOTE:
Background gradients take precedence over other chart backgrounds.  They are always white-
to-black blends.
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Charts
19. In the Summary group, select Sum.

20. Do not change Appearance.

21. Select the Filter tab.
22. Click on the Objects tab.
23. Double-click on the HRH Nbr Mjr to add to the Object.
24. Set the Operator to Between.
25. Set Value1 to W1DC03.
26. Set Value2 to W1NW54.

Chart Attributes

Draw Grid Select this check box to include grid lines in the output.

Percentile Bar Chart Select this check box to have calculations expressed as a percentage of the overall total.  For pie 
charts, which are always percentile charts, this item is called “% of Total” Labels and controls 
whether labels are shown as totals or percentages.

Display Labels Select this check box if you wish to output labels along the axes of the chart.  (Horizontal axis labels 
appear only when you use a Group By object.)

Display Legend Select to show an index of the colors/patterns corresponding to different Area Labels column values.  
(Only available when you use a Group By object.)

Appearance

Snap To Grid This has been defined in Chapter 3.

Hide This has been defined in Chapter 3.

Append Parent’s Filter This has been defined in Chapter 4, Parent/Child.

If you use the chart dialog box’s Filter tab to define a filter, selecting this check box 
combines the two filters using an AND relationship – rows must meet both filters in order 
to be included in the chart.

Unless you tell it otherwise, Eureka includes all database rows.  To have your chart include 
only those rows that are included in your document, make sure that the Append Parent’s 
Filter option is selected.

Native SQL Translate Value This check box controls whether Eureka Reporter Designer

Includes value translation requests as part of its query for chart information, or
Performs value translations itself

By default, Eureka does not include value translation requests as part of its query.  Check 
this box to have it do so.  When this is done, sorting and grouping are based on the 
translated value (when your database manager or ODBC database driver supports the SQL 
syntax required to do this).  If you want sorting and grouping based on the untranslated 
value, make sure this box is not checked.
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Charts
27. Click Add.

28. Click OK.
29. Save your report.
30. Process your report.

31. Close your report.

NOTE:
You can set a specific query filter to control which rows are included in the chart.  To do this, 
select the Filter tab from the Chart dialog box.

The entries you make on this tab affect which rows are included in your chart.  They do not 
affect when the chart is included in your document.  To set the conditions that affect when the 
chart is included, select the Output When tab.

If you both select Append Parent’s Filter and set up a query filter using the filter tab on the 
Chart dialog box, the two filters work together.  Only rows satisfying both filters will appear.
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Crosstabs

Unit of Study:  A crosstab object is an object that outputs an entire cross-tabulation document.  It 
uses three component objects:  columns, rows, and aggregate.  The crosstab provides an aggregate 
calculation, such as total, count, etc. for the aggregate object for each different combination of values in 
the other two objects.

Crosstabs are similar in appearance and function to a matrix, or spreadsheet-style, document.  Like chart 
objects, crosstab objects generate a query that is completely separate from the original document query.

A chart object is used to illustrate graphically your report output.

Think of a crosstab as a special type chart.  It is similar to appearance and function to a matrix or 
spreadsheet-style document.  The rules which applied to creating a chart object, generally are the same 
for a crosstab object.

A crosstab object outputs an entire cross-tabulation document (a crosstab, for short) (think of an Excel 
spreadsheet).  In its simplest form, a crosstab uses three component objects. Each must be a column or a 
custom object from your Metadata file.

An object defined in your Metadata file for the crosstab's vertical columns. We call this the 
columns object. These values are listed across the top of the crosstab.

An object for crosstab lines. We call this the rows object. These values are listed at the beginning 
of each line of the crosstab.

An object to be summarized in the cells of the crosstab. We call this the aggregate object.

The crosstab provides an aggregate calculation, such as total, minimum, average, etc., for the aggregate 
object for each different combination of values in the other two objects.

Crosstabs are stored in files separate from your design document.  This allows the same crosstab to be 
reused as a building block in additional design documents.

Activity:  FSC Inventory with output to include crosstab to illustrate graphically your data results.

Report Type:  FSC Inventory listing to include HRH Nbr with sum of property value.

Activity:  Student Hands-On with Instructor direction
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Crosstabs
Instructions:

1. Create a new FreeForm report.

2. Select the crosstab icon  from the tool bar.
3. Insert the crosstab object into the detail area of your document.
4. Double-click on the crosstab icon.

5. Crosstab File Name:  Enter FSC Inven-
tory.  Eureka will automatically add the .iqr 
extension.

6. Click on the Columns tab  (if it isn’t already 
selected).

7. Scroll to the END ITEM SERIAL Business 
View.

8. Double-click on the Quick_Start! folder.

9. Click, drag and drop the FSC field to the Columns window.
10. Click, drag and drop the HRH Nbr Mjr field to the first Rows window.
11. Click, drag and drop the Acq Cost to the second Rows window.  The Aggregate radio button will 

default to Sum.

12. Column Title:  Enter FSC Inventory.
13. Row Title:  Enter HRH.
14. De-select the Scale to Object in the Appearance area.

NOTE:
Select objects within each entry box in 
the order they should be used.  To 
change the order, they must be 
removed and re-added.  To remove an 
object, select it and press Delete.

NOTE:
The Swap Axis button swaps the definition for columns and rows.  After clicking this button, 
the columns that were used to define crosstab columns are used for the crosstab rows.  The 
columns that were used to define crosstab rows are used for the crosstab columns.

NOTE:
If you want to include totals for the columns and/or rows, then check the appropriate box(es).  
This default is checked.
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Crosstabs
15. Click on the Crosstab Styles button.
16. Select the style with the red border.

17. Click on the Filter tab.
18. Click on the Objects button in the Object 

directory.
19. Double-click on the Acq Cost field to move 

it to Object.
20. Set the Operator to > (greater than).
21. Set Value1 to 10000.
22. Click Add.
23. Double-click on the FSC field to move it to 

Object.
24. Set the Operator to Between.
25. Set Value1 to 3411.
26. Set Value2 to 3930.
27. Click Add.
28. Click OK.
29. If your default page setting is not already set 

to Landscape, change your page setup to 
Landscape.

30. Save your report as CROSSTAB.
31. Process your report.

Example of finished report:
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Three-Dimensional Crosstabs

Eureka can also create a three-dimensional crosstab.  Place a database column in the Sheet Groups control 
of the dialog box.  When Sheet Groups are used, Eureka outputs a separate crosstab (not necessarily a 
separate “sheet” or “page”) for each different value in the column.  For instance, using Manufacturer as 
the Sheets column will generate separate crosstabs for each manufacturer as well as combined totals for 
all manufacturers.

Using Multiple Column, Row, Cell, and Sheet Objects

More than one database column can be used in the above objects.  When multiple database columns are 
used, Eureka outputs a line (or column or sheet) for every combination of values.

Building and Using Crosstab Libraries

Each crosstab object refers to and/or creates a child object, allowing you to build a library of crosstab 
objects to use in different documents.

To use an existing crosstab design file as a crosstab object:

1. Open the crosstab dialog box.

2. Click the Browse button  next to the Crosstab File Name input box.  Eureka opens a file selection 
dialog box.

3. Select the file containing the crosstab you want to include.  Eureka reads the file and displays its val-
ues in the dialog box.

If a password was assigned to the document, Eureka prompts you for the password before loading the file.  
A password is assigned by opening the crosstab design (*.iqr) file in Eureka  Passwords cannot be 
assigned in the crosstab dialog box.  Make any desired changes to the crosstab object and click OK.  Be 
sure to change the file name shown at the bottom of the dialog, so you do not overwrite the file that was 
imported.

NOTE:
If you want to prevent sheets from being split between two pages, do not select the Scale to 
Object option for the crosstab.  When you select Scale to Object, Eureka will split sheets over 
pages (depending on the size of the object, the size of your page, and similar factors).
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Graphics

Unit of Study:  Graphics represent a type of output object that will be included in your document 
when it is viewed or printed.

Application:  This process is for adding graphics (output objects) to a new or existing document.

Report Type:  Open the FFACTY report.

Activity:  Student Hands-On with Instructor direction

Instructions:

1. Open your FFACTY report.

2. Select the graphic icon  from the tool bar.

3. Place the graphic object in the left-hand side margin of the Document Header area.
4. Double-click the graphic object.

5. Enter a label for your graphic object.
6. Set the Height to 1.04.
7. Set the Width to 1.04.

NOTE:
Use the Height and Width to make 
your graphic larger or smaller.

A graphic is only as big as the graphic object 
that is placed on your report.

You can also resize the object by clicking on the 
object once, and then grab the handles and 
drag the object to the desired size.
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Graphics
8. Click on the Image/Border tab.
9. If you want a border around your graphic, 

click on the list box and select the desired 
Line Weight.  You can also set the point size, 
add shadowing and use customized settings.

10. If you want a background for your graphic, 
select a pattern; otherwise, check the 
Transparent check box.

11. If desired, change the border, shadow, fill, 
and/or pattern color(s).

12. Click on the browse button next to File 
Name.

13. Change Look In: to C:.
14. Double-click on Eureka.
15. Double-click on Reporter.
16. Double-click on Designer.
17. Double-click on the Sample folder.
18. Double-click on the World.bmp file.

You will notice that in the Sample area, a picture of your graphic is displayed.
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19. Click OK.

Example of the Design Document:

20. Click OK.
21. Save your report.
22. Process your report.

Example of the finished report:

23. DO NOT close the report – we will continue to use it in the next Unit of Study.
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Creating Icons For Your Desktop

Unit of Study:  This process will show you how to create a report icon for your desktop.

Application:  When you want your documents to be viewed, printed, or exported directly from 
Windows by creating a program item or shortcut represented by an icon that you designate to be in 
Start>Programs>Accessories.

Report Type:  Open the report FFACTY

Activity: Student Hands-On with Instructor direction

Instructions:

1. Open the FFACTY report.
2. Select Tools from the menu bar.
3. Select Auto Shortcut Builder… from the program group.

4. Description:  Eureka will default this field with 
your report title.  Depending on which radio but-
ton you select (View, Print, or Export), it will be a 
part of your Description.

5. Accept the default View.

6. Export Format:  If you selected Export, you will 
need to select the export format.

7. Click on the Program Group list box and select Accessories (All Users).  Your icon will be save to 
the Program Group that you specify.

8. Click on the list box for Current Icon.
9. Select your desired icon.
10. Click OK.
11. Save your report.
12. Close your report and return to your desktop.

NOTE:
You cannot create an icon for a NOT YET SAVED document!!!

View Select this if you want to view your report on the 
screen.

Print Select this to sent your report directly to your 
default printer.

Export Select this to export your report to another applica-
tion.
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Creating Icons For Your Desktop
13. Click on the Start button.
14. Select Programs.
15. Select Accessories.
16. Select Eureka-Reporter Designer View_FFACTY.

Your report will be automatically processed and displayed.

17. Close the output window.
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Creating Labels

Unit of Study:  To create labels in Eureka, you can use the Avery label templates.  Templates are 
predefined design documents that you can use as a model for a new document.  These templates include 
objects on them but are not linked to specific columns.  You also have the option of creating custom 
templates of your own.

Labels in are created with a new document from a template.  When you select New From Template from 
the File menu, Eureka opens a file selection dialog box.  Use the List Files of Type control to select the type 
of template you want to start with.  Select the template you want to use.  Most templates distributed with 
Eureka are installed into the template subdirectory of the Eureka directory.  Templates for use with Avery 
mailing labels are installed into template\avery.  When you click Open, the selected template is loaded and 
a new window for it is opened with the name Untitled.

Application:  This process involves the use of predefined design templates to specify specific data you 
want to appear on a label.

Report Type:  Label design listing Stock Nbr, Nomen, Bar Cd, Location, Serial Nbr, plus who the 
property is assigned to.

Activity:  Student Hands-On with Instructor direction

Instructions:

1. Click File>New From Template.
2. Look in:  Select C:.
3. Double-click on the Eureka folder.
4. Double-click on Reporter.
5. Double-click on Designer.
6. Double-click on Template.
7. Double-click on the Avery folder.
8. Change Files of type to Mailing Labels (*.iqm).
9. Select A4_I7160.iqm.

After choosing a label design, it will produce a screen similar to the above, depending on what label design 
was selected.
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10. Double-click on COLUMN.
11. Scroll to the END ITEM SERIAL business 

view.
12. Scroll to the Serial_Hand_Receipt folder.
13. Double-click on Bar Cd.
14. Click OK.  You are returned to the Design 

Document.
15. Click OK.
16. Using the table below, repeat the steps for 

the remaining label fields.

17. Save your report as Label.
18. Process your report.

19. Close the report viewer.
20. Close your report.

BUSINESS VIEW:  END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)

Catalog Stock Nbr
Nomen

Serial_Hand_Receipt Loc
Serial Nbr

Hand_Receipt_Holder HRH Nbr Mjr
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